
Подготовка
макетов
Общие рекомендации
• припуски
• растровые элементы
• шрифты    1   2   3   4
• связанные объекты

Офсетная печать
• сумма красок    1   2
• оверпринт    1   2

Запись pdf-файла
• Adobe InDesign, Illustrator
• CorelDRAW

Лифлет 2 фальца

Брошюры
• На пружину
• На скрепку
• На термопереплет

Широкоформатная печать

Плоттерная резка

Вырубка (тигель)
папки, упаковка, крючки, 
любая вырубная продукция

Факапы

Шаблоны (скачать)

«Припуски – это беда», — скажет любой менеджер, технолог, печатник 
типографии, потому что припуски — это самая распространенная ошибка 
дизайнеров при создании макетов для печати.
Припуски под обрез  — область заливки за пределами обрезного формата. 
На рисунке ниже обрезной формат (т.е. линия реза) обозначен красной 
линией, а припуски – оранжевым цветом.
Значимые элементы макета (текст, логотипы и т.д.) не должны располагаться 
близко к контуру реза изделия. Безопасное поле от обреза до таких 
элементов зависит от вида продукции, в среднем составляет 3-5 мм.

печать / резка

Припуски

Припуск под обрез
Все элементы макета, выполненные

в край листа, должны иметь 
техническое поле за границу реза –

минимум 2 мм

На примере формата А4

Безопасное поле
3-5 мм до контура реза

Контур реза в размер
210х297 мм

210 мм

2 мм

2 мм
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Печатное разрешение
Разрешение растровых элементов должно лежать в пределе 220-300 dpi, 
для газет допустимо 150-200 dpi. Bitmap — не менее 600-1200 dpi.

Цветовая модель
Не допускается наличие цветов, отличных от CMYK, Grayscale или Pantone. 
Стандартный цветовой профиль CMYK - ISO Coated v2 300% (ECI). Pantone - Solid Coated.

Растровые элементы

Следует проверить два основных критерия 
перед отправкой файла в формате psd.

Файл должен быть сохранен 
в цветовой модели CMYK (Grayscale для ч/б). 
Проверяем цветовую модель в документе:

Меню Изображение (Image) — Режим (Mode) 
— CMYK (Grayscale).

Проверяем печатное разрешение макета:

Меню Изображение (Image) — 
Размер изображения (Image Size)...

В открывшемся окне параметр Разрешение 
(Resolution) указывает ткущее значение точек 
на дюйм (pixels/Inch). Как на рисунке ниже.

 Если цветовая модель документа отличается 
от требуемой, необходимо корректно перевести 
ее в CMYK через меню Редактирование (Edit) — 
Преобразовать в цветовой профиль (Convert to Profile). 
В появившемся окне в графе Профиль (Profile) выбрать 
из списка Lab и нажать OK. Затем повторить порядок 
действий, но в выпадающем списке выбрать профиль 
ISO  Coated v2 300% (ECI).

2

1

Пример проверки растрового изображения/макета в программе Adobe Photoshop

https://yadi.sk/d/4J8XnEy9L8v8sQ
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Шрифты в кривые

Очень часто в техтребованиях встречается просьба перевести шрифты в кривые. Зачем 
это нужно? Всё очень просто. Мы хотим иметь ноль проблем при работе с вашим макетом. 
А наличие шрифтов — мощный потенциальный источник проблем.
Например, вы забудете приложить шрифты (не переведя текст в кривые). Без них макет 
не откроется в типографии (если это не PDF или PostScript). Программа вёрстки просто 
скажет: «не найден шрифт такой-то».
Шрифтов великое множество, и отыскать нужный - крайне сложная и утомительная 
задача. Также встречаются совершенно разные шрифты с одним и тем же названием. И это 
одна из множества сложностей.

Переводить или не переводить?

Итак: если ваш макет содержит относительно немного текста (например, визитка, флаер 
или небольшой буклет) — переведите шрифты в кривые.
Многополосные документы (журнал, газета, книга, каталог) нужно сдавать в типографию 
в шрифтах. Перевод текста в кривые серьёзно увеличит физический объём файла. И 
это повлечёт за собой не только неудобство при передаче макета в печать: некоторые 
программы вывода имеют определённые ограничения на количество узлов, и ваш файл 
рискует просто не вывестись.

На следующех страницах примеры перевода шрифтов в кривые
и способы передачи шрифтов для многостраничных публикаций.
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Чтобы готовый файл корректно открылся 
в типографии, нужно использовать функцию 
«Упаковать» (Package). Она позволяет создать 
папку с файлом, всеми используемыми 
шрифтами и графическими объектами.

 Без этих данных корректное 
открытие файла Illustrator на сторонних 
компьютерах будет невозможным.

Сохраняем исходник и переходим в меню 
Файл (File) — Упаковать (Package).
В появившемся диалоговом окне 
выбираем путь и название папки упаковки.

 Обязательно установите флажки, чтобы 
включить шрифты, связанную графику 
и параметры документа, как указано на 
скриншоте cправа.

Нажимаем Упаковать (Package).

Ваш документ, ссылки на изображения и 
шрифты будут включены в общую папку.

  Перед отправкой в типографию 
заархивируйте папку.

Подготовка файла Adobe Illustrator в типографию

 Если в макете вы используете 
коммерческий шрифт, а также если макет 
не является многостраничной продукцией, 
все шрифты можно перевести в кривые.

Выделите весь шрифт в документе, в меню 
Текст (Type) выберите команду Преобразовать 
текст в кривые (Create outlines), либо 
используйте горячие клавиши Ctrl+Shift+O.
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Шрифты

Чтобы файл публикации корректно открылся в типо-
графии, нужно использовать функцию «Упаковать» 
(Package). Она позволяет создать папку с файлом 
публикации, всеми используемыми шрифтами 
и графическими объектами.
 Без этих данных корректное открытие файла 
InDesign на сторонних компьютерах невозможно.

Сохраняем публикацию и переходим в меню Файл (File) 
— Упаковать (Package). В появившемся окне повторно 
нажимаем кнопку Упаковать (Package).

Подготовка файла Adobe InDesign в типографию

Далее последует диалоговое окно (опционально), ука-
зывающее, что будет записан текстовый файл с печат-
ными инструкциями. Нажимаем Продолжить (Continue).
Выберите путь и название папки упаковки.

 Обязательно установите флажки, чтобы включить 
шрифты, связанную графику и параметры документа, 
как указано на скриншоте ниже.

	D Скопировать шрифты (Copy Fonts)

	D Скопировать связанную графику (Copy Linked Graphics)

	D Обновить связанную графику в пакете (Update Linked Graphics In Package)

	D Включить IDML-файл (Include IDML)

Нажимаем Упаковать (Package).

 Если в макете вы используете 
коммерческий шрифт, а также если макет 
не является многостраничной продукцией, 
все шрифты можно перевести в кривые.

Выделите весь шрифт в документе, в меню 
Текст (Type) выберите команду Преобразовать 
текст в кривые (Create outlines), либо 
используйте горячие клавиши Ctrl+Shift+O.
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Перед отправкой файла в типографию
в формате CorelDraw, переведите весь текст
в кривые и проверьте.

Выделите текст, правой  кнопкой мыши
в появившемся меню выберите пункт
Преобразовать в кривую (Convert to curves).
Горячие клавиши Ctrl+Q.

Далее необходимо проверить, что весь текст
в документе переведен в кривые.
Заходим в меню Файл (File) —
Свойства документа (Document Properties)...

В открывшемся меню ищем строку
Статистика текста (Text Statistic).
Ниже должна быть информация о том,
что текстовые объекты отсутствуют.

Подготовка файла CorelDRAW в типографию
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Выделите изображение и в нижней части рабочей 
области появится информация об объекте.

Связанные объекты

При работе в программах Adobe InDesign 
и Adobe Illustrator не используйте OLE-объекты 
(объекты, вставленные в макет через буфер обмена). 

Используйте команду Place (Ctrl+D) для помещения 
объектов в макет.

Недопустимо использование дублирующихся 
имен для связанных файлов.

Информация о связанных объектах находится 
в окне Связи (Links). Клавиши Ctrl+Shift+D.

В CorelDRAW помещайте растровые 
изображения в цветовой модели CMYK.
Так минимизируется риск искажения цветов 
при выводе макета на печать.

Adobe

CorelDRAW
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Сумма красок для офсетной печати

После отправки файла в печать на офсет просьба типографии для дизайнера может стать 
неожиданностью. Автору макета будет предложено переделать пару фотографий, 
у которых сумма красок в глубоком черном больше 300%.

Давайте разберемся, что такое сумма красок, и как ее контролировать в макете.

Четыре краски CMYK, каждая 
от 0 до 100%, накладываясь друг 
на друга, образуют сумму красок.

Каждый вид бумаги имеет свою плотность, 
впитываемость и растискивание точек краски. 
Превышение требуемого лимита красок может 
привести к неполному закреплению краски на 
бумаге и, как следствие, к отмарыванию 
(грязи на соседних страницах).

Чтобы избежать подобного брака, в программах предусмотрены 
инструменты, контролирующие сумму наносимой краски.

 Сумма красок (total ink) в макете не должна 
превышать 300%. Рекомендуем для офсетной 
печати цветоделение производить посредством 
профиля ISO Coated v2 300% (ECI).

Скачать

Отмарывание краски на сосдней странице
при превышении лимита суммы красок

Проверка суммы красок 
в Adobe InDesign

Выберите в меню Окно (Window) — 
Вывод (Output) — Цветоделение 
(Separation preview). Выставьте значение 
Суммарное покрытие (Ink Limit) в 300%, 
(Рисунок 1).

Режим отображения публикации изме-
нится на черно-белый. При этом все 
объекты, сумма красок которых будет 
превышать 300%, будут подсвечены на 
макете красным цветом (Рисунок 2).

Рис. 2Рис. 1
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Чтобы программы Adobe InDesign, Photoshop, 
Illustrator «увидели» нужный цветовой профиль, 
его следует поместить в папку: 
C:\Windows\System32\spool\drivers\color

После обнаружения повышенной суммы красок возникает необходимость снизить порог 
до нужного значения.

Шаг 1. Цветовые настройки программы. 
Чтобы настройки цветоделения были корректными, в программках дизайна и верстки 
необходимо подключить цветовой профиль CMYK — ISO Coated v2 300% (ECI) — Скачать

Шаг 2. Назначение профиля и нужной суммы красок:
• загружаем изображения в Adobe Photoshop. Переводим картинки в CMYK:
Редактирование (Edit) — Преобразовать в профиль (Convert to Profile),

• назначаем профиль ISO Coated v2 300% (ECI) и сохраняем.

Подключение цветового профиля

Сумма красок для офсетной печати

Пакет программ Adobe CorelDRAW

Меню Редактирование (Edit) — 
Настройка цветов (Colour Settings):

Меню Инструменты (Tools) — 
Управление цветом (Colour Settings) — 
Параметры документа (Document Settings):

https://yadi.sk/d/4J8XnEy9L8v8sQ
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Оверпринт для офсетной печати

Краски CMYK достаточно прозрачны и, смешиваясь между собой, создают различные 
цвета и оттенки. Когда мы накладываем два разноцветных объекта, для сохранения 
нужного нам цвета программы делают в нижнем объекте вырубку (Knockout) по форме 
верхнего. На мониторе проблемы не возникает, так как вырубка находится точно под 
объектом. Однако при печати небольшое смещение красочных фотоформ (Misregistration) 
может привести к незапечатанным областям вокруг верхнего объекта (иллюстрация 1). 
Для устранения подобного недочета был придуман метод наложения красок - оверпринт.

на малые объекты с заливкой 100% 
черного цвета: текст < 12–14 pt; обводки 
и линии толщиной менее 1–2 мм (3–6 pt).

1. На цветные объекты, кроме случаев
из пункта «Оверпринт назначается».
2. На белые объекты.

РР

Р

Overprint

Overprint назначается: Overprint не назначается:

Без оверпринта

Чтобы избежать ненужного смешивания красок на печати 
при наложении цветнах объектов друг на друга программы 
делают «вырубку». Из-за неприводки фотоформ могут 
возникать непрокрашенные зазоры.

Вырубка

Наложение 
Overprint

С оверпринтом

Назначение атрибута Overprint некоторым объектам удаляет 
«вырубку» на слое под верхним объектом, исключая 
незапечатывание.

1

2
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Оверпринт для офсетной печати

Ниже указаны настройки параметра «оверпринт» в разных графических программах.

Adobe Illustrator

Adobe InDesign 

Adobe Photoshop

CorelDRAW

Опции оверпринта вызываются через 
меню Окно (Window) — Атрибуты (Attributes), 
или сочетанием клавиш Ctrl + F11.

При помощи той же палитры, 
что и в Иллюстраторе осуществляется 
включение оверпринта в Adobe InDesign: 
Окно (Window) — Вывод (Output) — 
Атрибуты (Attributes).

В фотошопе нет оверпринтов.

Оверпринт включается при помощи 
меню Правка (Edit) — Наложение заливки 
(Overprint Fill), либо этот же параметр 
активируется в выпадающем меню правой 
кнопкой мыши по нужному объекту.

Для того, чтобы выставить оверпринт на какой либо объект, 
необходимо выделить этот объект при помощи инструмента 
Selection Tool и поставить галочку Overprint Fill в верхней 
части палитры Атрибуты (Attributes), либо Overprint Stroke, 
если мы хотим выставить оверпринт на обводку объекта.

Р
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Запись pdf-файла

Перед записью файла PDF для печати 
проверьте размер страниц и припуски 
под обрез (Bleed).

См. пункт припуски.

Adobe InDesign  и Adobe Illustrator

Скачайте файл Uraltipigraf.joboptions. 
Подключите данный файл с настройками:

File > Adobe PDF Presets > Define

В появившемся окне Нажмите Load.
Укажите расположение файла Uraltipigraf.joboptions.

Скачайте файл Uraltipigraf.joboptions. 
Подключите данный файл с настройками:

Edit > Adobe PDF Presets... >

В появившемся окне Нажмите Import.
Укажите расположение файла Uraltipigraf.joboptions.

File > Save As…

В открывшемся окне выберите формат файла Adobe PDF. 
Если в публикации несколько страниц, можете задать 
диапазон. Нажмите Сохранить (Save).

В следующем диалоговом окне выберите
установки записи Uraltipograf, как это показано на рисунке. 
В них можно ничего не менять. Нажмите Save (Сохранить).

File > Adobe PDF Presets > Uraltipograf…

В открывшемся окне выберите путь и имя файла 
для сохранения. Нажмите кнопку Сохранить (Save).

В открывшемся окне в первой вкладке General
вы можете выбрать диапазон страниц для экспорта. 
Остальные настройки менять не нужно.
Нажмите Export (Экспортировать).

 Размер припусков под обрез (bleed):

• для цифровой печати — 2 мм
• для офсетной печати — 5 мм

В многостраничных макетах внутренний 
припуск под обрез (Inside) не ставится.

Приступаем к экспорту PDF

Установка настроек

https://yadi.sk/d/iJT822fTCxUx4A
https://yadi.sk/d/iJT822fTCxUx4A
https://yadi.sk/d/iJT822fTCxUx4A
https://yadi.sk/d/iJT822fTCxUx4A
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CorelDRAW

Запись pdf-файла

Общие (General)
• Диапазон экспорта: Текущий документ

(Export range: Current Document).

• Заготовка PDF: Допечатная подготовка
(PDF preset: Prepress).

Цвет (Color)
• Использовать параметры цвета документа

(Use document color settings)

• Вывод цвета: как в исходном файле
(Output color as: Native)

• Убираем галочку 
Встраивание цветовых профилей
(Embed color profiles)

Документ (Document)
• Отобразить при загрузке: Только страница

(On start, display: Page only)

• Кодирование: двоичное
(Encoding: Binary)

Объекты (Objects)
Тип сжатия: ZIP 
(Compression type: ZIP)

Ставим галочки 
• Сжать текст и штриховой рисунок

(Compress text and line art)

• Экспортировать весь текст как кривые
(Export all text as curves)

• Субдискретизация изображения
(Bitmap Downsampling):

- Цвет (Color)....................................................... 300
- Оттенки серого (Grayscale)....................... 300
- Монохромный (Monochrome).................1200

Допечатная подготовка (Prepress)
Порог выхода за обрез (Bleed Limit):

– 2 мм для цифровой печати
– 5 мм для офсетной печати

Для создания PDF из Corel Draw идем в Файл (File) — 
Опубликовать PDF... (Publish to PDF...)

В появившемся окне в нижней части выбираем 
Параметры (Settings).

Далее настраиваем следующие параметры 
по вкладкам:

Нажимакем ОК и сохраняем файл.

1
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Лифлет 2 фальца

На схеме приведены стандартные размеры лифлета 
с двумя бигами формата А4 (297х210 мм).

Для внешней части лифлета рассчет размеров будет 
вычисляться по формуле слева направо: (Х-1) (Х) (Х+1). 
Для внутренних страниц зеркально.

Припуски составляют 2 мм.

Шла Саша
по шоссе

Конец

 Фальцовка (фальцевание) — 
складывание печатного листа для формирования 
идеально ровного сгиба. Операция производится 
механическим способом.

Евро
2 фальца

Гармошка
2 фальца

Лицевая сторона

припуски под обрез

Внутренний разворот

При подготовке лифлета необходимо опрделится со схемой фальцовки. 
Ширину страниц, складывающихся во внутреннюю часть лифлета, нужно сделать немного 
меньше. (см. пример ниже).
Стоить обратить внимание, чтодля обратной стороны лифлета размеры фальцовки будут 
зеркальными лицевой части.

Обложка

98 мм 100 мм99 мм 99 мм100 мм

2 мм

2 мм

98 мм
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Брошюра на пружину

При подготовке 
к брошюрованию 
пружиной обратите 
внимание на расстояние 
от значимых объектов до 
перфорации. Важно, что бы 
информация не попадала на 
границу отверстий брошюровки. 
Она находится на расстоянии 8 мм от 
края страницы (после подрезки в формат).
Желательный отступ от края листа до 
информации – 13-18 мм.
Поля четных и нечетных полос должны быть 
различными ( зеркальными).
Все размеры даны от готового формата макета.
Не стоит забывать про припуски 2 мм (см. припуски).

При брошюровке пружина вытесняет среднюю часть блока за обрезной формат. 
Обложку при этом лучше делать чуть большего размера чем блок — на 1-2 мм.

8 мм
13 мм (минимум)

Tекст

обложка

подложка
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Спуск полос

Брошюра на скрепку

При большом объеме необходимо учитывать компенсацию бига. В центральной части 
брошюры листы будут смещены из-за толщины корешка.

Порядок полос (страниц)

Количество полос для печати на скрепке должно быть кратно четырем (4, 8, 12, 16 и. т.д.).
Каждая полоса должна быть на отдельной странице. Нельзя предоставлять полосы 
разворотами (например, 1-2  |  3-4  |  5-6 и т.д.).
Порядок полос должен быть последовательный, т.к. спуск полос для печати под скрепку 
создается типографией, исходя из последовательности полос в файле заказчика.

Подрезка

 Спуск полос — 
процесс размещения полос издания на 
монтаже и печатной форме, обеспечивающий 
после фальцовки и резки оттисков требуемое 
чередование страниц в готовом изделии.

Лицевая часть

Последовательность страниц в макете Компоновка при спуске полос

Оборотная часть

1 2 3 4
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Брошюра на термопереплет

Данный тип переплета отличается от других 
изданий тем, что скрепление предварительно 
подобранных листов блока с обложкой 
происходит путем склеивания их по корешку 
полиуретановым клеем.

При термоклеевом скреплении 
раскрытие изделия невысокое. Это 
необходимо учитывать при верстке 
макета. На странице в районе корешка 
будет «невидимая зона» порядка 5-7 мм.

Толщину корешка при макетировании 
обложки можно рассчитать самостоятельно 
исходя из средних толщин бумаги. Но лучше 
сложить стопку из бумаги, на которой будет 
печататься изделие и померить ее высоту.

Офсетная.............. 80 г/м2.............0,095 мм

Мелованная.......... 80 г/м2.............0,061 мм

Мелованная.......... 90 г/м2.............0,065 мм

Мелованная........ 100 г/м2.............0,075 мм

Мелованная........ 115 г/м2.............0,080 мм

Мелованная........ 150 г/м2.............0,115 мм

Мелованная........ 170 г/м2.............0,125 мм

Мелованная........ 200 г/м2.............0,150 мм

Мелованная........ 220 г/м2.............0,165 мм

Мелованная........ 250 г/м2.............0,190 мм

Мелованная........ 270 г/м2.............0,210 мм

Мелованная........ 300 г/м2.............0,235 мм

Мелованная........ 350 г/м2.............0,300 мм

Приведены средние значения 
толщин бумаги разных сортов 
и производителей. Допустимые 
погрешности толщины корешка 
позволяют ими пользоваться.
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Широкоформатная печать

Разрешение
На графике ниже показана логика 
применения разрешений файлов исходя 
из  расстояний от потенциального 
наблюдателя до объекта.

Требования к макетам для широкоформатной печати

растровых файлов:

• свести все слои в один фоновый слой (Background)

• не должно быть альфа-каналов (Channels) и путей (Paths)

• цветовое пространство CMYK, 8 bits
• без внедрения цветового профиля
• размер 1:1

векторных файлов:

• растровые изображения должны быть внедрены в файл
• все шрифты должны быть переведены в кривые
• эффекты и тени должны быть прорастрированы
• в случае предоставления макета в уменьшенном формате 

(например, 1:10) обязательно проверьте, что бы в контурах
была установлена опция Scale with image (масштабировать

с изображением).

Объем файла: до 400 Мб.

Формат файла
TIFF, PSD, CDR, PDF, EPS, Ai

Цвет
Цветовая модель СМYK.
Черный цвет должен быть составным 
(например: C75, M68, Y67, K90), в противном 
случае цвет получится не черным, а темно-
серым с заметными горизонтальными 
полосками. В несоставном сером также 
будет «полосить».

 Примечание:

Прикладывайте к макету просмотровый файл (в формате jpeg), а так же сопроводительное письмо с указанием точных параметров 
заказа – размер, материал, кол-во экземпляров и описание послепечатной обработки (если таковая предусмотрена).

Наилучшее решение – предоставлять макеты для широкоформатной печати в растровом формате TIFF, соблюдая указанные выше 
требования. В TIFF файле должны быть сведены все слои в один слой Background и должны быть удалены все дополнительные каналы 
и пути. В этом случае, Вы будете застрахованы от неожиданностей в процессе печати. Хотя понятна трудность, возникающая в 
данном случае – передача файла (большой объем файла).

Много мелкого текста вытянутая рука 2-3 шага

250-300 dpi 150-200 dpi 75-100 dpi

Особенности подготовки
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Плоттерная резка

1. Файл с контурами реза должен быть
в векторном формате cdr: CorelDraw
версии 16 и ранее.

2. Шрифты должны быть в кривых (Curves):
выделите текстовый фрейм в CorelDraw 
и используйте комбинацию Сtrl+Q.

3. Масштаб 1:1

4. Минимальное расстояние от контура реза
до края изображения или информации 3 мм
размер вылетов 3 мм

5. Все линии должны иметь наименьшую
толщину (Hairline)

6. Контуры должны быть замкнутые.

7. Не должно быть пересекающихся линий,
острых углов, градиентов и прочих эффектов.

8. Минимальная высота и ширина элементов
в макете 5 мм

9. Никаких объектов, выходящих за пределы
области резки, прикрытых или неприкрытых
белыми прямоугольниками-масками.

 Совет:
Для того чтобы подготовить файл *.ai 
(Adobe Illustrator) к плоттерной резке, 
необходимо сохранить его в EPS версии 
Illustrator 8. В файле не должно быть 
эффектов, прозрачностей, градиентов. 
Полученный файл открыть в программе 
CorelDraw и сохранить в версии 16 и ранее.

 Для самостоятельной раскладки 
элементов на печатном листе скачайте 
шаблон с крестами (метками), 
необходимыми для сведения 
контуров и изображений.

Скачать шаблон

Ai
Требования к макетам для плоттерной резки

ШЛА САША
ПО ШОССЕ

ПО ВСТРЕЧНОЙ
ПОЛОСЕ...

https://yadi.sk/d/LOgs6ye6xCRPKQ
https://yadi.sk/d/LOgs6ye6xCRPKQ


Подготовка
макетов
Общие рекомендации
• припуски
• растровые элементы
• шрифты    1   2   3   4
• связанные объекты

Офсетная печать
• сумма красок    1   2
• оверпринт    1   2
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папки, упаковка, крючки, 
любая вырубная продукция

Факапы

Шаблоны (скачать)

1. Макет файла для вырубки
предоставляется в векторном формате:
CorelDraw версии 16 и ранее.

2. Файл не должен содержать внедренных
шрифтов и посторонних элементов,
белых или прозрачных контуров —
ничего кроме контуров вырубки и
биговки.
Шрифты должны быть в кривых (Curves):
выделите текстовый фрейм в CorelDraw 
и используйте комбинацию Сtrl+Q.

3. Толщина контура не менее 0,25 pt
и не более 1 pt.

4. Контуры для вырубки и биговки
обозначаются разными цветами:
контур для вырубки — красным цветом,
сплошной линией
контур биговки — синим цветом,
пунктирной линией

5. К файлу приложите текстовый документ
(txt) с пояснением, что это — лицевая
сторона штампа или лицевая сторона
печати,
а также pdf или jpg-файл, на котором
видно как вырубка совмещается с
печатным изображением.

Вырубка (тигель)

Требования к макетам для вырубных форм

Припуск под обрез
Все элементы макета, 
выполненные в край листа,
должны иметь техническое 
поле за границу реза –
минимум 3 мм

хенгер (на дверь)

Безопасное поле
3 мм до контура реза

Контур реза
в размер файла

Контур бига
(линия сгиба)
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Отсутствие припусков
на резку (вылетов)

Излюбленный прием. 
Чревато присутствием белой рамки 
вокруг готового изделия и зарезки 
значимых элементов, что с эстетической 
точки зрения «прям не очень».

См. припуски

Низкое разрешение растровых 
элементов

Минимум это 150 dpi. И уже в этом 
случае заметно низкое качество картинки. 
От рекомендуемых 300 dpi не стоит 
отклонятся. 200-300 dpi – вот наш 
рабочий диапазон.

См. растровые элементы

До 300 dpiПосле 72 dpi
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Отсутствие шрифта 
(макет не в кривых)

Файлы, подготовленные в кореле, 
иллюстраторе, индизайне, фотошопе 
(редко). В макете текст не преведен в 
кривые и при этом используется шрифт, 
отсутствующий в типографии.

См. шрифты

Превышение суммы красок 
(офсетная печать)

В основном наблюдется в картинках. 
и местах наложения черного текста. 
Когда сумма красок превышает 
рекомендованный лимит в 300%, на 
соседней/соприкасающейся странице 
образуется отмар краски.

См. сумма красок

Задумка заказчика Левая страницаВ типографии Правая страница
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Использование в черном тексте 
4-х красок (офсетная печать)

В этом случае вокруг текста появится 
разноветная кайма трех цветов: голубого, 
пурпурного и желтого. Может сойти за 
новомодный 3D-эффект, который мы 
можем наблюдать в 3D-кинотеатре без 
спецочков.

См. сумма красок

Отсутствие оверпринта 
на черном тексте 
(офсетная печать)
Из-за особенностей технлогии печати 
невозможно точно попасть в белое поле, 
оставшееся от черного элемента. В итоге 
имеем белую кайму вокруг черного 
текста.

См. оверпринт

Также касается мелких элементов дизайна, 
линий в таблицах, тонких линиий в чертежах, 
линий в рисунках.

Также касается мелких элементов дизайна, 
линий в таблицах, тонких линиий в чертежах, 
линий в рисунках.

Факапы
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Ниже по ссылкам можете скачать уже готовые шаблоны с инструкциями и подсказками 
для самых ходовых печатных изделий (листовка, лифлет, еврофлаер, визитка и т.д.).

Шаблоны представлены
в ходовых форматах:

Визитка

Еврофлаер

Листовка

Лифлет (2 бига)

Шаблон для плоттерной резки

CorelDRAW Adobe Illustrator Adobe Photoshop Adobe InDesign

https://yadi.sk/d/vugjSQi4ORViwQ
https://yadi.sk/i/1shJ6Sl81kiECQ
https://yadi.sk/i/JaDdYqhV39kiMg
https://yadi.sk/d/z5ka-1RZberS7g
https://yadi.sk/d/vATAP_UMDdLCQg
https://yadi.sk/d/uD3diynz24-NeQ
https://yadi.sk/d/nyYaAi2c1UIRcw
https://yadi.sk/d/TcNE8voRxANzlQ
https://yadi.sk/d/6BoKdnwNXg-n9A
https://yadi.sk/d/XUDSYIVcjk3ywQ
https://yadi.sk/d/Rlu6pSOe3Ae4eA
https://yadi.sk/d/kiPJy9x-TOMrEQ
https://yadi.sk/d/gkVe6_eO_z-guw
https://yadi.sk/d/Ps8pJ2304w-cRA
https://yadi.sk/d/Sssvc_I-Ow8GSw
https://yadi.sk/d/LOgs6ye6xCRPKQ



